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Introduction to PowerPoint 
 
 
 

Learning Module Objectives 
 
When you have completed this 
learning module you will have 
seen how to: 
 

• Start PowerPoint using the Start Menu 
• Start PowerPoint using a Desktop Shortcut 
• Start PowerPoint via Start Menu Office commands 
• Start PowerPoint and use the AutoContent Wizard 
• Start PowerPoint and use the Design Template option 
• Start PowerPoint and use the Blank Presentation option 
• Start PowerPoint using the Microsoft Office Shortcut Bar 
• Open a recently used PowerPoint file 
• Increase the list of recently opened files 
• Open an existing presentation 
• Move up one folder level 
• View a files is different ways 
• Save a presentation 
• Close PowerPoint 
• Exit PowerPoint 
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What is PowerPoint 2003? 
 
Background Microsoft PowerPoint 2003 is part of the Microsoft Office 2003 suite of programs.  

Its primary function is for producing presentation materials as follows. 
 

On-screen 
presentations 

You can design, produce and deliver on-screen presentations that include color, 
clipart, sound, animation and video clips. 
 

Overhead 
transparencies 

You can print your slides in either portrait or landscape formats for the creation of 
overhead transparencies.  If you have the correct printer type you can print directly 
onto acetates in color. 
 

35 mm slides Should you wish to use 35 mm slides for your presentation formatting and sending 
a presentation file to a service bureau can achieve this. 
 

Paper printouts It is possible to print out slides onto paper for review and/or use within discussions. 
 
 

Handouts  You can print handouts for delegates that contain reduced size copies of your 
slides, with multiple sides per page. 
 

Notes PowerPoint is also able to produce notes pages with one slide per page. These can 
be used by speakers to write their presentation or by delegates to record their own 
notes. 

 
Outlines PowerPoint is able to produce presentation outlines containing as much or 

as little information as required.  These can be used by the presenter as a 
guide/crib sheet. 
 

Banners (for 
Web sites) 

Used for creating small rectangular banners that can be placed on a Web 
site page. 
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Starting PowerPoint 
 
To start 
PowerPoint 
using the Start 
Menu 

• Display the Start Menu and select Microsoft PowerPoint.  (This is normally 
located in the Programs group). 

 
 
 

To start 
PowerPoint 
using a Desktop 
Shortcut 

You may have a PowerPoint shortcut installed on your desktop if this is the case:  
 
• Double click the PowerPoint shortcut icon. 
 
 

To start 
PowerPoint via 
Start Menu 
Office 
commands 

• Display the Start menu and select New Office Document from the Start menu. 
• Select a Blank Presentation from the General tab and click the OK button. 
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The Opening PowerPoint Screen 
 
Background This point gives you four options.  The first three options can be used when 

creating a new presentation.  We will look at each of these in turn now and deal 
with the fourth at a later stage. 
 

To start 
PowerPoint and 
use the 
AutoContent 
Wizard 
 

This will aid in the production of your presentation by giving suggestions as to what 
the content should be in specific cases such as when producing a training 
presentation or a business plan presentation. 
 

To start 
PowerPoint and 
use the Design 
Template 
 

Choosing this option will allow you to select one of a number of background 
templates on which to produce your presentation. 

To start 
PowerPoint with 
a Blank 
Presentation 

This option provides you with (as the name suggests) a clean blank slide 
on which to produce your own presentation.  You will be prompted for the 
type of slide layout when you select this option. 
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PowerPoint and Microsoft Office 
 
Background PowerPoint is part of the Microsoft Office suite and as such is able to share 

information freely with Word, Excel and Access. 
 

To start 
PowerPoint 
using the 
Microsoft Office 
Shortcut Bar 

Depending on how your copy of PowerPoint has been installed, you may see the 
Microsoft Office Shortcut Bar displayed.  This is normally displayed along the side 
of the screen (or maybe across the top or bottom of the screen) and allows you to 
create or open Microsoft Office documents. 



Introduction to PowerPoint  8 
PowerPoint 2003  Notre Dame University 

 
 

Slides and Presentations 
 
What is a slide?  The basic building block of any PowerPoint presentation is the slide.  

 
A slide will normally be produced in either Portrait and Landscape layout in any one 
of a number of paper formats.  Slides can also be formatted for either an “On-
screen” format or a format suitable for the production of 35 mm transparencies.   In 
addition there is a Banner option for use with Web pages. 
 
Slides can contain titles, body text, drawn objects, charts, objects and 
shapes, clipart, movies, sound and items created within other applications. 
 

What is a 
presentation? 

A series of slides grouped together is referred to as a presentation and all the 
individual sides are stored within a single presentation file. 
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Opening an Existing Presentation 
 
To open a 
recently used 
PowerPoint file 

Opening a file, sometimes known as loading a file, is 
the process of opening a presentation file within the 
PowerPoint application window .  The files are copied 
from a disk drive on your system, (or from another disk 
drive on a network) into your PCs RAM (Random 
Access Memory).  
 
A list of the four most recently opened files is 
displayed under the File menu (the default is four 
files).  You can open these files by clicking on them. 

  

 
 

To increase the 
list of recently 
opened files 
 

• Open the Tools menu and choose Options.  
• Select the General tab. 
• Increase the value in the Recently used file list making sure its check box is 

selected. 
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To open an 
existing 
presentation 

• Either click on the Open icon  
 
OR from the File menu choose the Open command  
 
OR press Ctrl+O  
 

• The Open dialog box is displayed. If the file you want to open is contained in 
another folder or drive, move to that location using the Look in: list box. 

• To open the file you require, click on the file to select it and then click on the 
Open button. 

 
Tools to help 
you with 
opening files 

You can use the icons across the top of the Open dialog box to help you in locating 
and selecting the required file. 
 

 
 

 Icon Function 
   
  Click on the Down arrow to display folders 

(directories) and drives. 
 

To move up 
one folder level  

Click here to move up one level through your folder (directory) tree. 
 
 

To search the 
Web  

Click here to search the Web. 
 
 

To delete a file 
 

Click here to delete the selected file (you can also select a file and press 
the Delete key). 
 

To create a 
new folder  

Click here to create a new folder beneath the level of the selected folder. 
 
 

To access 
tools for file 
and folder 
manipulation 

 
Click here to select different views of your 
files and folders.  Repeatedly clicking on this 
icon will cycle through the various views 
available.  Of you click on the drop down 
arrow next to the icon to review a list of 
selectable views. 
 

 
 

  Clicking on this icon will display a range of 
tools for manipulating files and folders, as 
illustrated. 
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Saving a Presentation 
 
To save a 
presentation  

• Click on the File drop down menu and select Save to see the Save As dialog 
box as illustrated above (this assumes that you have not previously saved the 
file, in which case the new version of the file will simply overwrite the old 
version of the file). 

• Ensure that you are located in the Folder/Disk drive of your choice by clicking 
the arrow to the right of the Save in drop down list box and navigating to your 
required location. 

 
 • Enter the filename in the File name 

text box.  The file name can be up 
to 255 characters in length.  

Filenames cannot include any of the 
following characters: forward slash 
(/), backslash (\), asterisk (*), 
question mark (?), quotation mark (“), 
greater-than sign (>), less-than sign 
(<), pipe symbol (|), colon (:), or 
semicolon (;). 
 

 • Click the Save button to complete the file save process. 
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Closing a Presentation and Exiting PowerPoint 
 
To close 
PowerPoint  

• Open the File menu and select Close 
 
or click on the Close Window icon, as 
illustrated. 

 

 
 

 • If unsaved changes have been made to your presentation the dialog box 
illustrated is displayed, giving you the chance to save the presentation prior to 
closing. 

 

 
 
• Click Yes to save the presentation before closing 

 
OR click No to close without saving changes 
 
OR click on the Cancel button to cancel the operation. 

 
To exit 
PowerPoint  

• Click on the Close icon at the top, right of your PowerPoint application window. 
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Review Questions – How Would You … 
 

1.  Start PowerPoint using the Start Menu? 
 

2.  Start PowerPoint via Start Menu Office commands? 
 

3.  Start PowerPoint and use the AutoContent Wizard? 
 

4.  Start PowerPoint and use the Design Template option? 
 

5.  Start PowerPoint and use the Blank Presentation option? 
 

6.  Start PowerPoint using the Microsoft Office Shortcut Bar? 
 

7.  Open a recently used PowerPoint file? 
 

8.  Increase the list of recently opened files? 
 

9.  Open an existing presentation? 
 

10.  Move up one folder level? 
 

11.  See your favorite documents? 
 

12.  Select different views of your file and folder listing? 
 

13.  Save a presentation? 
 

14.  Close PowerPoint? 
 

15.  Exit PowerPoint? 
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The PowerPoint Screen and Views 
 
 
 

Learning Module Objectives 
 
When you have completed this 
learning module you will have 
seen how to: 
 

• Start a new presentation 
• Open an existing presentation 
• Save the active presentation 
• Print a presentation 
• Spell check a presentation 
• Cut objects from a presentation 
• Copy objects from a presentation 
• Paste objects into a presentation 
• Copy formats from one object to another 
• Undo/redo an action 
• Insert a hyperlink 
• Display the Web Toolbar 
• Insert a Word table 
• Insert a chart 
• Insert a new slide 
• Modify the Slide layout 
• Modify the Slide Design (i.e. using a template) 
• Select a black and white view of a presentation 
• Change view size 
• Open the Office Assistant 
• Change font face 
• Change font size 
• Apply or remove, bold, italic or underlining formatting 
• Apply a shadow to text 
• Adjust text alignment 
• Apply or remove bullets 
• Change paragraph spacing 
• Increase/decrease font size 
• Change paragraph indent 
• Use Animation Effects 
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The Standard Toolbar 
 
To start a new 
presentation  

 

Will start a new presentation alongside any existing ones. 

To open an existing 
presentation  

 

Will open an already existing presentation. 

To save the active 
presentation  

 

Will save the active presentation. 

To email a presentation 
 

 

Will allow you to email a presentation to anyone connected 
to your network or via the Internet. 

To print a presentation 
 

 

Will print the active presentation.  

To spell check a 
presentation  

 

Will spell check the active presentation. 

To cut objects from a 
presentation  

 

Will cut objects from a presentation to the Clipboard.  
Keyboard shortcut is: Ctrl+X 

To copy objects from a 
presentation  

 

Will copy objects from a presentation to the Clipboard. 
Keyboard shortcut is: Ctrl+C 
 

To paste objects into a 
presentation  

 

Will paste objects from the Clipboard to a presentation.  
Keyboard shortcut is: Ctrl+V 
 

To copy formats from 
one object to another  

Will allow you to select the format of an already existing 
object and apply it to another object. 
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To undo/redo an action 
 

Will allow you to undo an action or redo an action - up to 
150 times. 
 

To insert a hyperlink 
 

Will allow you to insert a hyperlink into your document, which 
is useful for directly linking to a Web location. 
Keyboard shortcut is: Ctrl+K 
 

To display the Tables 
and Borders toolbar  

Will toggle the display of an extra toolbar for manipulating 
tables and borders. 
 

 
 

To insert a table  Displays a drop down, which will allow you to insert a table 
into your presentation. 
 

 
 

To insert a chart 
 

 

Will insert a Microsoft Chart into the active slide. 

To insert a new slide 
 

Will insert a new slide into the active presentation. 
Keyboard shortcut is: Ctrl+M 
 

To "Expand All", i.e. to 
show all the 
information 

 
Toggles between showing all the information within a 
presentation outline and only title details. 
 
 

To show formatting 
 

Toggles between displayed the presentation outline as 
formatted or non-formatted. 
 

To preview in black 
and white 
 

 
 

Will switch between black and white and color views of the 
active presentation. 

To change view size 
 

 

Zoom Control (10% - 400%). 
 

To open the Office 
Assistant  Will allow you to get help using the Office Assistant. 

Keyboard shortcut: F1 
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The Formatting Toolbar 
 
To change font face 

 
 

Will allow you to change the font of the 
selected text. 

To change font size 
 

 

Will allow you to change the size of the selected text. 

To apply or remove, 
bold, italic or 
underlining formatting 

 
Will embolden the selected text. 
 
 
 

To apply a shadow to 
text  

 

Will place a shadow behind the selected text. 

To adjust text 
alignment  

Will align text to the left, center the text or align text to the 
right. 
 

To apply or remove 
bullets or numbering  

Will turn bullets or numbering, on or off. 
 
 

To increase/decrease 
font size  

 

These icons will increase/decrease the font size of the 
selected text.  

To change paragraph 
indent  

 

Will increase or decrease paragraph indentation, also 
referred to as Promote/Demote. 

To use Animation 
Effects 
 

 
Enables you to add animation effects to your presentation. 
 

To access common 
tasks 

Displays a drop down list of common tasks, such as New 
Slide, Slide Layout and Apply Design Template 
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Status Bar 
 
Background  The Status Bar located at the bottom of the PowerPoint screen provides you with 

information relating to the view you have active. 
 
It also provides you with information as to which slide you are editing and the 
design template you are using. 
 
Double clicking on the template name will display a dialog box allowing you to apply 
alternative design templates to your presentation, as illustrated.  This will be 
covered in detail elsewhere. 
 

 
 
Double clicking on the spelling icon  will spell check the active area of the 
slide that you are working on. 
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The View Icons 
 
Background Just above the Status Bar on the left-hand side of the screen you will find the 

PowerPoint View icons.  These are used to change the view of PowerPoint 
presentation that you are working in. 
 
The Views available are: 

• Normal View 
• Outline View 
• Slide View 
• Slide Sorter View 
• Slide Show View 
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Normal View 
 
Background  This is probably the view you will spend most of your time in when using 

PowerPoint.  It is the view most suited to constructing and editing PowerPoint 
slides. 
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Outline View 
 
Background In this view of PowerPoint you work in classic outline view seeing only slide titles 

and main points.  This view can be useful for putting together your first stage draft 
of a presentation (the skeleton layout). 
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Slide View 
 
Background  Displays a picture on the current slide that you are working on. 
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Slide Sorter View 
 
Background  This view enables you to see a large proportion of your presentation displayed as 

small representations of each slide.  In this view you may copy and move slides to 
change the order of your presentation.  It is possible to select both individual and 
multiple slides for copying and moving.  
 
This is also the view from which you may copy whole slides for pasting into another 
application e.g. Word.  



The PowerPoint Screen and Views  25 
PowerPoint 2003   Notre Dame University 

 

 
 

Slide Show View 
 
Background This view is used to run your PowerPoint presentation as an on-screen show with 

all effects, animation and transitions active (which will be covered later).  
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Review Questions – How Would You … 
 

1.  Start a new presentation? 
 

2.  Open an existing presentation? 
 

3.  Save the active presentation? 
 

4.  Print a presentation? 
 

5.  Spell check a presentation? 
 

6.  Cut objects from a presentation? 
 

7.  Copy objects from a presentation? 
 

8.  Paste objects into a presentation? 
 

9.  Undo/redo an action? 
 

10.  Insert a chart? 
 

11.  Insert clip art? 
 

12.  Insert a new slide? 
 

13.  Modify the Slide layout? 
 

14.  Change view size? 
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15.  Open the Office Assistant? 

 
16.  Change font face? 

 
17.  Change font size? 

 
18.  Apply or remove, bold, italic or underlining formatting? 

 
19.  Apply a shadow to text? 

 
20.  Adjust text alignment? 

 
21.  Apply or remove bullets? 
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Using AutoLayout 
 
 
 

Learning Module Objectives 
 
When you have completed this 
learning module you will have 
seen how to: 
 

• Add a new slide to a presentation 
• Add a new line/paragraph within a frame 
• Move from the title text box to other slide text boxes 
• Enter bulleted text 
• Indent or demote a bullet 
• Create a slide containing Two Column Text 
• Create a slide containing a Table 
• Create a slide containing a Text and Chart 
• Create a slide containing an Organization Chart 
• Create a slide containing a Chart 
• Create a slide containing Text and Clipart 
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Choosing an AutoLayout 
 
Background When creating a new PowerPoint slide you are given the option of selecting a slide 

layout from a wide selection of AutoLayout options.  Note that you can scroll down 
the New Slide dialog box to display more slide layout option. 
 

To add a new 
slide to a 
presentation 

New slides can be added to a presentation in a number of ways as described 
below. 
 
• From the Insert drop down menu, select the New Slide command 

 
OR press the Ctrl+M key combination  

OR click the New Slide icon on the standard toolbar . 
 

 • Following any of the above methods you will be presented with the New Slide 
dialog box.  A brief description of the selected layout appears at the bottom 
right-hand corner of the dialog box.  

• When you have made your selection pressing Enter or clicking OK will action 
your choice.  

 
 The New Slide dialog box is also displayed when you first commence the creation 

of a presentation.  At this point Title Slide Layout is the default AutoLayout 
presented to you.  However, when adding a new slide to a presentation the slide 
layout offered by default will be the same as the slides currently in use. 
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The Title Slide 
 
 A simple slide layout with text boxes for the inclusion of both a title and subtitle. 

 
 
 

Select the Title text box by clicking with the mouse. 

To add a new 
line/paragraph 
within a text box 
 

• Press Shift+Enter to add a new line within a slide text box. 
• Press Enter to add a new paragraph. 
 

To move from 
the title text box 
to another text 
box 

Move from the title text box to the subtitle text box using the Ctrl+Enter key 
combination (or click on the subtitle text box using the mouse) 
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Bulleted List 
 
 Two text boxes are available in this slide layout, a title text box, and a bullet text 

box.  Move from the title to the bullet text box as in the title slide. 
 
This slide layout is generally used by most people as their standard slide as it is 
useful for presenting the main points within a presentation. 
 

To enter 
bulleted text 

• Click within the Click to add text section on the slide. 
• Enter text for the first bullet point. 
• Press Enter to move to the next bullet and enter text. 

 
To indent or 
demote a bullet 

To indent or demote a bullet point to the next level down: 
 
• Either press the Tab key  

 
OR click on the Demote icon on the Format toolbar. 
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Two Column Text 
 
 This layout is useful for presenting two sides of an argument with one 

column being used to provide the positive side and the other the negative.   
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Table 
 
 This layout is used to produce a slide containing a table.  Double clicking on the 

Table icon within the slide will display the following dialog box, allowing you to 
specify the number of rows and columns. 
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Text and Chart 
 
 The Text and Chart slide AutoLayout allows for the creation of slides containing a 

chart (i.e. a graph) and bulleted text. Clicking on the icon and adjusting a set of 
default values produces the chart. 
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Organization Chart 
 
 This slide layout allows for the creation of slides containing an 

organizational chart.  Clicking on the chart icon within the slide produces 
the chart. 
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Chart (i.e. Graphs) 
 
 This slide layout allows for the creation of slides containing a chart (i.e. a graph).  

Clicking on the chart icon produces the chart. 



Using AutoLayout  38 
PowerPoint 2003  Notre Dame University 

 
 

Text and Clipart 
 
 Here we have a slide layout that allows for the inclusion of a piece of clipart 

alongside a set of bullet points. 
 
Graphical clipart can be used to help make a point, to add humor to a 
presentation, to illustrate a topic and to give a presentation some “color” 
and “life”. 
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Blank (slide) 
 
 This AutoLayout gives you a blank slide with no pre-formatted text or object areas.   
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Review Questions – How Would You … 
 

1.  Add a new slide to a presentation? 
 

2.  Add a new line/paragraph within a text box? 
 

3.  Move from the title text box to other slide frames? 
 

4.  Enter bulleted text? 
 

5.  Indent or demote a bullet? 
 

6.  Create a slide containing Two Column Text? 
 

7.  Create a slide containing a Table? 
 

8.  Create a slide containing a Text and Chart? 
 

9.  Create a slide containing an Organization Chart? 
 

10.  Create a slide containing a Chart? 
 

11.  Create a slide containing Text and Clipart? 
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Using the AutoContent Wizard  
 
 
 

Learning Module Objectives 
 
When you have completed this 
learning module you will have 
seen how to: 
 

• Use the AutoContent Wizard when you open PowerPoint 
• Use the AutoContent Wizard if you have already opened 

PowerPoint 
• Select the Presentation Type 
• Enter title slide details 
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Starting the AutoContent Wizard 
 
To use the 
AutoContent 
Wizard when 
you open 
PowerPoint 

• Open Microsoft PowerPoint. 
• Select AutoContent Wizard from 

the PowerPoint dialog box. 
• Click OK. 
• The AutoContent Wizard dialog 

box is displayed. 
• Click Next and move to the next 

dialog box. 
 

 
 

To use the 
AutoContent 
Wizard if you 
have already 
opened 
PowerPoint 

• From within PowerPoint open the 
File menu. 

• Select New. 
• The New Presentation dialog box 

is displayed (as right). 
• Select the General tab. 
• Double click on the AutoContent 

Wizard icon. 
• Click Next to move to the next 

dialog box  
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Selecting a Presentation Type Within the AutoContent Wizard 
 
 First you need to 

select the type of 
presentation that 
you wish to 
create.  If you use 
the All, then you 
can use the scroll 
bar to move down 
the list and then 
select the type of 
presentation that 
you are interested 
in.   

 
 

 NOTE: Many of the options displayed may not be installed on your system and 
you may be asked to insert the Microsoft Office installation CD-ROM when you 
select some of these AutoContent options. 
 
In this example we have selected the General button, which displays a number 
of pre-formatted presentations.  In the example illustrated we have then selected 
the Generic AutoContent Wizard.  Click on the Next button to continue. 
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Presentation Type 
 
 The next step is to decide how you will use your presentation once it has been 

produced.  In this case we have selected On-screen presentation 
 

 
 
• Click on the Next button to continue working through the Wizard. 
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Presentation Titles, Footers and Slide Numbers 
 
 You can enter a title name for the presentation, details of your name and 

organization, plus any additional information that you wish to be recorded. 
 
• Click on the Next button to continue working through the Wizard. 
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Completing the Wizard 
 
 • Click Finish to complete the AutoContent Wizard 

 
 From this point you need to open each slide and, using the guidelines 

supplied, modify the content to meet your requirements and needs. 
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The Finished Presentation 
 
 The above title slide was produced using the AutoContent Wizard. 
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The Presentation Content 
 
 The slide above shows the contents of the presentation displayed in Slide Sorter 

View.  Below is a view (in Slide View) of the opening slide. 
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Review Questions – How Would You … 
 

1.  Use the AutoContent Wizard when you open PowerPoint? 
 

2.  Use the AutoContent Wizard if you have already opened PowerPoint? 
 

3.  Select the Presentation Type? 
 

4.  Enter title slide details? 
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Creating a Simple Text Slide 
 
 
 

Learning Module Objectives 
 
When you have completed this 
learning module you will have 
seen how to: 
 

• Create a new presentation 
• Select a slide layout 
• Enter titles and primary bullets 
• Enter a new line that is not preceded by a bullet point 
• Increase and decrease the space between lines 
• Create sub-level bullets 
• Promote and demote sub-level bullet points 
• Create a Text Slide in Outline View 
• Start a New Slide in Outline View 
• Insert a new slide 
• Reduce the view of a slide to title only 
• Expand a collapsed slide 
• Collapse all slides 
• Expand all slides 
• Create a Summary Slide 
• Toggle “Show Formatting” display 
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Creating a New Blank Presentation 
 
To create a new 
presentation 
when you start 
PowerPoint 

• Start PowerPoint. 
• Select Blank Presentation from the dialog box. 
• Click OK. 
 
 

To create a new 
presentation 
once 
PowerPoint is 
“up and 
running” 

• Either open the File menu and select New. 
• Select Blank Presentation from the dialog box. 
• Click OK. 
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Selecting a Slide Layout 
 
To select a slide 
layout 

• From the New Slide dialog box, select the required slide layout.  In the 
example shown the Title Slide layout has been selected. 

• Click on the OK button to confirm your slide layout selection. 
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Simple Text Slide 
 
To enter title 
and primary 
bullets 

To create a slide with a title and a set of primary bullet points do the following: 
 
• Click on the “Click to add title” section of the slide and enter your slide title. 
• Click on the “Click to add text” section of the slide and enter the text for the 

first bullet point. 
• Press Enter and type in the information making up the next bullet point. 
• Continue until you have typed in all your bullet point information (strongly 

suggest a maximum of 6 per slide). 
 

To enter a new 
line that is not 
preceded by a 
bullet point 

• At the end of a line, instead of pressing the Enter key, press Shift+Enter.  
This will jump the cursor down to the next line without preceding the line by a 
bullet point symbol. 
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What is 
demotion and 
promotion of 
paragraphs? 

Demoting a paragraph means that the paragraph will be indented from the left.  
Also the type of bullet symbol used will change.  A demoted paragraph can be 
promoted at any time, causing the paragraph to move to the left (and again the 
bullet symbol will change).   Use demotion and promotion of paragraphs to break 
up the appearance of your bullet point and to highlight your main points within a 
slide. 
 

To demote 
bullets using 
the Tab key 

• Press the Tab key to create a sub-level bullet 
prior to entering bullet text.  
 
Each Tab moves one level down. 

 

A Simple Slide

• Primary Bullet
– Second Level Bullet

• Third Level Bullet
– Fourth Level Bullet

• Fifth Level Bullet

• Bullet two
• Bullet III

 
To promote sub-
level bullets 
using the tab 
key 

• Press the Shift-Tab key to promote sub-level 
bullets prior to entering bullet text. 

 
 

 
 
 
 
 
 

A Simple Slide

• Primary Bullet
– Second Level Bullet

• Third Level Bullet

– Second Level Bullet
• Third Level Bullet
• Third Level Bullet
• Third Level Bullet

• Primary Bullet

 

To demote 
bullets using 
the Demote icon 
  

• Select bullet points and adjust the levels (individually or by 
group) using the Demote icon on the Format toolbar. 

 
 

 

To promote 
bullets using 
the Promote 
icon 

• Select the bullet points and adjust the levels (individually or by 
group) using the Promote icon on the Format toolbar. 
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To Insert a New Slide 
 
To insert a new 
slide using the 
keyboard 

• If you are working in Normal or Slide View and wish to enter a title for a new 
slide, press Ctrl+Enter and you will automatically generate a new slide. 

 
 

To insert a new 
slide using the 
mouse 

• Position the cursor within the presentation where you wish to insert the new 
slide and click on the New Slide icon. 
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Deleting and re-ordering slides within a presentation 
 
To delete a slide Select the slide icon in Normal View and press the Delete key.  The slide icons are 

displayed down the left hand side of the screen in Normal and Outlining view 
 

To re-order the 
slides within a 
presentation 

• If necessary display the presentation in Outline or Normal View. 
• Use the mouse to drag the slide icons up or down the page. 
 
Alternatively display the Outlining toolbar (by clicking on the View drop down menu, 
selecting Toolbars, and then selecting Outlining).  Use the Move Up or Move 
Down icons.   
 
NOTE: If the Move Up or Move Down icons are not active within the Outlining 
toolbar, it is most likely because you have not yet selected a slide icon (displayed 
down the left hand side of the screen in Normal and Outlining view). 
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Manipulating Slide Information within Normal and Outline 
View 
 
To reduce the 
display of a slide 
to title only 

• Select the slide by clicking on the Slide Icon. 
• Click the Collapse icon and the slide view will change to 

show only the title with a line underneath to signify that it 
has been collapsed. 

 

 

To expand a 
collapsed slide 

• Select the slide you wish to expand by clicking on the Slide 
Icon 

• Click the Expand icon and the slide view will change to 
show the full contents of the slide. 

 

 

To collapse all 
slides 

• Click the Collapse All icon and the outline will change to 
show only the slide titles, each with a line underneath to 
signify that it has been collapsed. 

 

 

To expand all 
slides 

• Click the Expand All icon and the outline will change to 
show the full content of each slide. 

 
 

To create a 
Summary Slide 

• To produce a summary of all the slides in a presentation, 
make sure that you are in Outline view.  Click on the first 
slide to select it.  Depress the Shift key and click on the 
last slide within the presentation.  Release the Shift key 
and all the slides will remain selected.  Click on the 
Summary Slide icon and a slide containing summary 
information is automatically produced. 

 

 

To toggle “Show 
Formatting” 
display 

• Click the Show Formatting icon to either turn the display 
of formatting on or off.  
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Creating Notes for your Slides 
 
To create notes 
for a page 

• Display your presentation in Normal View and click on the area displaying the 
message "Click to add notes". 

• Enter the required text. 
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Review Questions – How Would You … 
 

1.  Create a new presentation when you start PowerPoint? 
 

2.  Create a new presentation once PowerPoint is “up and running”? 
 

3.  Select a slide layout? 
 

4.  Enter title and primary bullets? 
 

5.  Enter a new line that is not preceded by a bullet point? 
 

6.  Increase the space between bullet points? 
 

7.  Decrease the space between bullet points? 
 

8.  Create sub-level bullets using the Tab key? 
 

9.  Promote sub-level bullets using the Tab key? 
 

10.  Create sub-level bullets using the Demote icon key? 
 

11.  Create sub-level bullets using the Promote icon? 
 

12.  Create a Text Slide in Outline View? 
 

13.  Switch to Outline View and start a new presentation? 
 

14.  Enter slide titles? 
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15.  Add bullet points? 

 
16.  Demote bullet level in Outline view using the Tab key? 

 
17.  Demote bullet level in Outline view using the Demote icon key? 

 
18.  Start a New Slide in Outline View? 

 
19.  Insert a New Slide using the keyboard? 

 
20.  Reduce the view of a slide to title only? 

 
21.  Collapse a slide? 

 
22.  Expand a collapsed slide? 

 
23.  Collapse all slides? 

 
24.  Expand all slides? 

 
25.  Create a Summary Slide? 

 
26.  Toggle “Show Formatting” display? 

 
27.  Create slide notes in Normal View? 
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Formatting and Proofing Text 
 
 
 

Learning Module Objectives 
 
When you have completed this 
learning module you will have 
seen how to: 

• Select a word 
• Select characters using the mouse 
• Select characters using the Keyboard 
• Select all text within a text box 
• Change font or typeface 
• Change font size 
• Embolden text 
• Italicize text 
• Underline text 
• Add a shadow to text 
• Change text color 
• Adjust text alignment 
• Adjust paragraph spacing 
• Format text using the Format drop down menu 
• Set the default text formatting for all new objects 
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Formatting Options 
 
Background Placing text onto a slide as we have seen is a relatively easy thing to do.  If you 

format slide text it allows you to add impact and “color” to your presentation. 
 
Text formatting can be used to enhance text in a number of ways as follows: 
 

• Font or Typeface 
• Type size 
• Bold 
• Italic 
• Underline 
• Shadow 
• Color 
• Alignment 
• Paragraph spacing 
• Bullets 

 
Each of the above options has a different effect on the person viewing the slide. We 
will now look at each in turn. 
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Select Then Do! 
 
 Remember, in PowerPoint as in all Microsoft Windows applications you should first 

select the item you wish to adjust and then apply the formatting. 
 
You should note that it is possible to select either single or multiple objects. 
 

To select a word • Placing the cursor within a word will allow the application of formats to a single 
word. 

 
To select 
characters 
using the 
mouse 

• Position the mouse pointer at the point where you wish to start selecting text. 
• Depress the left mouse button. 
• Move the mouse in any direction. 
• When the required text is highlighted, release the mouse button and the text 

will remain selected. 
 

To select 
characters 
using the 
Keyboard 

• While holding down the Shift key select the characters you wish to format with 
the up, down, left, and right cursor keys. 

 
 
 

To select all text 
within a text box 

If you wish to apply formatting to all text within a text box you need to carry out the 
following steps. 
• Click on a text item within the text box you wish to select.  A “gray” 

box/frame will appear around the text. 
• Click on the “gray” box to make it active. 
• Any formatting now applied will effect all the text within the text box. 
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Text Formatting 
 
 Mouse Keyboard 
To change font 
or typeface 

• Select text to be changed. 
• Click on the Font drop down arrow.

 
• Select desired font. 

• Select text to be changed. 
• Press the Ctrl+Shift+F key 

combination. 
• Press the Down Arrow key. 
• Select the desired font. 
• Press Enter. 

 
To change font 
size 

• Select text to be changed. 
• Click on the Size drop down arrow 

and select the size you require 

 
 

OR click on the Increase or 
Decrease Font icons. 

 

• Select text to be changed. 
• Press the Ctrl+Shift+P key 

combination. 
• Press the Down Arrow key. 
• Enter or select the desired size. 
• Press Enter. 
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 Mouse Keyboard 
To format text 
as bold 

• Select text to be changed. 
• Click on the Bold icon. 

 
 

• Select text to be changed. 
• Press the Ctrl+B key combination. 

 
 

To format text 
as italic 

• Select text to be changed. 
• Click on the Italicize icon. 

 
 

• Select text to be changed. 
• Press the Ctrl+I key combination. 

To format text 
as underlined 

• Select text to be changed. 
• Click on the Underline icon. 

 
 

• Select text to be changed. 
• Press the Ctrl+U key combination. 

To format text 
as shadowed 

• Select text to be changed. 
• Click on the Shadow icon. 

 
 

 

To format text 
as with a color 

• Select text to be changed. 
• Click on down arrow to the right of 

the Font Color icon (located on the 
Drawing toolbar). 

 
• Select desired color from the Color 

Palette displayed.  
 

 

To adjust text 
alignment 

• Select text to be changed. 
• Click on the appropriate Alignment 

icon. 

 
 

• Select text to be changed. 
• Choose one of following:  

Ctrl+L - Left 
Ctrl+R - Right 
Ctrl+E - Center 
Ctrl+J – Justify (i.e. align text 
on the left and right edges). 
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To format text 
using the 
Format drop 
down menu 

Extra font formatting effects are available within the Format menu.  To access the 
font formatting menu and apply these other formats: 
 
• Select text to be changed. 
• Open the Format menu and select the Font option to display the Font dialog 

box. 
• Select the appropriate items from those available. 
 

 
 

To set the 
default text 
formatting for 
all new objects 

The extra items available include Emboss, Superscript, and Subscript, and all 
items selected here can be made default by selecting the Default for new objects 
check box. 
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Review Questions – How Would You … 
 

1.  Select a word? 
 

2.  Select characters using the mouse? 
 

3.  Select characters using the Keyboard? 
 

4.  Select all text within a text box? 
 

5.  Change font or typeface? 
 

6.  Change font size? 
 

7.  Embolden text? 
 

8.  Italicize text? 
 

9.  Underline text? 
 

10.  Add a shadow to text? 
 

11.  Change text color? 
 

12.  Adjust text alignment? 
 

13.  Adjust paragraph spacing? 
 

14.  Format text using the Format drop down menu? 
 

15.  Set the default text formatting for all new objects? 
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Pictures and Backgrounds 
 
 
 

Learning Module Objectives 
 
When you have completed this 
learning module you will have 
seen how to: 
 

• Draw a line 
• Give the line a new style 
• Draw rectangles and ovals 
• Draw a Freeform shape 
• Edit a Freeform shape 
• Add an AutoShape 
• Change to a different AutoShape 
• Select a single object 
• Deselect a selected object 
• Select more than one object at a time 
• Select objects using the Selection Tool 
• Select all the objects on a slide 
• Cycle round all the objects within a slide 
• Group objects 
• Un-group objects 
• Un-group using a pop-up menu 
• Regroup objects 
• Re-size Objects 
• Re-size an object to exact percentages 
• Constrain objects when you re-size them 
• Align Objects 
• Move Objects 
• Enable “Snap to grid” 
• Rotate Objects 
• Cut, Copy, Paste and Duplicate objects 
• Move Objects Forwards and Backwards 
• Create a color scheme 
• Change color schemes 
• Add a Custom Background 
• Display the drawing pop-up menu 
• Select an object 
• Draw a line 
• Draw an arrowhead line 
• Draw an oval 
• Insert a Text Box 
• Insert a WordArt object 
• Fill an object with a color, texture or picture effects 
• Modify the font color 
• Add a 3-D effect to a selected object 
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The Drawing Toolbar 
 
To display the drawing 
pop-up menu  

Displays a pop-up menu allowing 
you to manipulate drawing 
objects. 

 
 

To select an object 
 

Select the object that you click on. To select multiple objects keep 
the Shift key depressed. 
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To free rotate an object 

 
Allows you to rotate an object by dragging with the mouse. 
 
 

To display the 
AutoShapes pop-up 
menu 

Displays the AutoShapes 
pop-up menu, from which 
you can select the 
category of AutoShape 
that you require. 

 
 

To draw a line 
 

Allows you to draw a line by dragging using the mouse. 
 
TIP: To draw a line that is perfectly horizontal or vertical, depress 
the Shift key while dragging. 
 

To draw an arrowhead 
line 

 

Allows you to draw an arrowhead line by dragging using the 
mouse. 
 
 

To draw a rectangle 
 

Allows you to draw a rectangle by dragging using the mouse. 
 
TIP: To draw a perfect square, depress the Shift key while 
dragging. 
 

To draw an oval 
 

Allows you to draw an oval by dragging using the mouse. 
 
TIP: To draw a perfect circle, depress the Shift key while 
dragging. 

To insert a Text Box 

 

Allows you to insert a Text Box by dragging using the mouse. 
 
 

To insert a WordArt 
object  

Allows you to insert a 
WordArt object which 
can be formatted using 
a range of advanced 
text formatting tricks 

 
 

To insert a clipart 
image  

Allows you to insert 
clipart into your 
presentation 
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To fill an object with a 
Color, texture or 
picture effects  

Allows you to fill an 
object with colors, 
texture or even 
pictures. 

 
 

To format line objects 

 

Allows you to format the 
color of a line or add 
pattern effects. 

 
 

To modify the font 
color  

Allows you to change 
the font color for 
selected text. 

 
 

To modify the style of a 
selected line  

Allows you to set the 
line style and thickness. 
Allows you to choose 
from a range of 
preformatted options 
displayed within a pop-
up. 

 
To set the type of 
dashed line used  

Allows you choice from 
a range of preformatted 
dashed style options 
displayed within a pop-
up. 
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To set the type of 
arrowhead line used  

Allows you choice from 
a range of preformatted 
arrow style options 
displayed within a pop-
up. 

 
 

To add a shadowed 
effect to a selected 
object  

Allows you choice from 
a range of preformatted 
shadow effect options 
displayed within a pop-
up. 

 
 

To add a 3-D effect to a 
selected object  

Allows you choice from 
a range of preformatted 
3-D effect options 
displayed within a pop-
up. 
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Using the Drawing Tools 
 
To draw a line 
 

• Select the Line icon from the Drawing toolbar.  The mouse pointer changes 
into a cross-hair pointer when moved over the slide.  
 

 
 
• Click at the location where you want the line to begin and drag.  Release the 

mouse button when you want the line to end. 
• A line appears between the beginning and end point. 
 

To format a line • Select the line to which you want to apply a new style and double click on it to 
display the Format AutoShape dialog box. 

 

 
 
• Modify options as required. 



Pictures and Backgrounds  77 
PowerPoint 2003  Notre Dame University 

 
To draw 
rectangles and 
ovals 

• Select the Rectangle or Oval icon from the Drawing toolbar.  The mouse 
pointer changes into a cross-hair pointer when moved over the slide. 

• Click at the location where you want the rectangle or oval to begin and drag to 
draw the object. 

• When you have finished, release the mouse button. 
 
NOTE:  When using any of the basic drawing tools, you can use the Shift key to 
constrain your shape.  For example, if you wanted to draw a perfect square using 
the Rectangle tool, hold down the Shift key while you drag to create the shape. 
The rectangle will be constrained, and the result is a square. 
 

To draw a 
Freeform shape 

• The Scribble Tool allows you to draw freeform shapes by hand. 
• Click on the AutoShapes button on the Drawing toolbar to display the 

AutoShapes menu. 
• Select Lines and then click on the Scribble icon.  The mouse pointer 

changes to a pen when moved over the slide. 
 

 
 
• Click at the location where you want to begin drawing and drag to draw the 

object. 
• When you have finished, release the mouse button. 
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AutoShapes 
 
What is an 
AutoShape? 

• An AutoShape (as the name suggests) is a shape that can be automatically 
generated for you.  These range from a simple line to a complex 3-D shape.  
Once created that are easily manipulated and formatted. 

 
To add an 
AutoShape 

• Click the AutoShapes button on the Drawing toolbar to display the 
AutoShapes menu.  Click on the AutoShape you require to select it. 

• Position the mouse pointer at the location where you want the AutoShape to 
begin.  Hold down the left-hand mouse button and drag to position the 
AutoShape on the slide.  

• Release the mouse button when the shape is the size and proportion you 
require.  

• If you want to adjust the shape further, select the shape and drag the 
adjustment handle. 
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The AutoShape 
menus 

Lines 

 

Connectors 

 
 

 Block Shapes 

 

Arrow shapes 

 
 
 

 Flowchart shapes 

 

Stars and banners 
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 Callouts 

 

Action Buttons 
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Using Clipart 
 
To insert Clipart • Click on the Insert Clip Art icon, located in the Drawing toolbar.  You may see 

a small dialog box reminding you that there is much more clip art available on 
the Microsoft Office CD-ROM installation disk.  If you do see this informational 
dialog, press OK to continue. 

• A gallery of clipart will be displayed. 
• Select the group that matches your requirements, such as Academic or 

animals. 



Pictures and Backgrounds  82 
PowerPoint 2003  Notre Dame University 

 
 • Make sure that the Pictures tab is displayed.  Use the scroll bars to scroll 

down through the available clip art.  
• Click once on the Clipart that you wish to insert.  In the example shown the 

frog picture has been selected. 
 

 
 
• Clicking on the first item in the pop-up menu (Insert clip) will paste the clipart 

into the presentation.  You may continue inserting other clipart into you 
presentation, and when finished, close the clipart dialog box. 

 
To search for 
clipart pictures 

• In the Search for clips section of the clipart dialog box, enter a word and 
press Enter.  In the example shows, the search word used was computer. 

 
To insert sounds 
or motion clips 

• Note that as well as static clipart you can use the Insert ClipArt dialog box to 
insert sounds and motion clips. 
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Selecting Objects 
 
To select a single 
object 

• Place the mouse pointer over a visible area of the object. 
• Click on the object to select it. 
 

To deselect a 
selected object 
 

• Click on the selected object while holding down the Shift key to deselect it. 
 

To select more 
than one object 
at a time 

• Click on the first object you want to select. 
• Press the Shift key and click on the next object you wish to select.  The first 

object remains selected. 
• Continue selecting objects as required.  
NOTE:  If you deselect a particular object by clicking on it while pressing the Shift 
key, no other selected objects will be affected. 
 

To select objects 
using the Select 
Objects icon 

• Click on the Select Objects icon on the Drawing toolbar.  
• Drag a box around the objects you wish to select.  
• Release the mouse button to select the objects. 
 
NOTE:  Make sure the box completely surrounds the objects you want selected. If 
an object is only partly surrounded, it will not be included in the selection. 
 

To select all the 
objects on a slide 

• Choose Select All from the Edit menu, or press Ctrl+A.  
 
Everything on the slide is selected, including titles, graphs, and bulleted 
text. 
Any changes you make will affect all the selected objects on the slide. 
 

To cycle round 
all the objects 
within a slide 

• Select one object. 
• Then use Tab key to cycle through all the objects of the slide (use Shift+Tab 

to cycle through in the reverse direction). 
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Grouping and Un-grouping Objects 
 
Background Objects can be grouped together so that they are treated as one single object.  

Once the objects have been grouped, any attributes applied to the single object 
will affect each separate object in the group. 
 

To group objects • Select the objects you wish to group, either by clicking on each object while 
holding down the Shift key, or by using the mouse to drag a selection 
rectangle around each object you want to select. 

• Click the Draw icon on the Drawing toolbar to display the Draw menu and 
select Group. 

• The handles around each individual object disappear, and handles are 
displayed around the selection rectangle that encompasses the object group. 

• Click on any of the objects to select the object group. 
 

To un-group 
objects 

• To work on each object individually, you need to un-group the object. 
• Select the group by clicking on one of the objects. 
• Click the Draw icon on the Drawing toolbar and select Ungroup. 
• The handles around the group disappear, and the handles are restored for 

each object. 
 

To un-group 
using a pop-up 
menu 
 

• Select a grouped object and then right click to display the pop-up menu. 
• Select Grouping and then the Ungroup command. 
• The handles around the group disappear, and the handles are restored for 

each object. 
 

To regroup 
objects 

• To regroup the most recently un-grouped objects, select one of the objects 
from the group. Click the Draw icon on the Drawing toolbar and select 
Regroup. 
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Re-sizing Objects 
 
To re-size an 
object 

• Click on the object to select it.  Click on one of the re-size handles around the 
object.  The mouse pointer changes to a cross-hair pointer. 

• Drag the re-size handle until the object is the size you require, and release 
the mouse button. 

 
To re-size an 
object to exact 
percentages 

• Right click on the object and from the shortcut menu select Format. 
• Click on the Size tab to display the Size folder. 
• To re-size the selection by an exact percentage, adjust the Height and Width 

spin boxes in the Scale section of the dialog box. 
• Select OK. 
 

To constrain 
objects when you 
re-size them 

• To re-size an object vertically, diagonally, or horizontally from one corner, so 
that the height to width relationship of the object is maintained.  Hold down 
the Shift key and click on one of the corner handles then drag to re-size. 

• To re-size an object from the center outwards. Click on one of the corner 
handles and then hold down the Ctrl key and drag to re-size. 

• To re-size an object vertically, diagonally, or horizontally from the center 
outwards.  Click on one of the corner handles and then hold down Ctrl+Shift 
and drag to re-size. 

 
To re-size a line • Click on the line to select it.  Re-size handles are displayed at each end of the 

line. 
• Drag the re-size handles to increase or decrease the length of the line. 
• An image of the line is displayed as you drag to enable you to see the effect 

of re-sizing it. 
• The opposite end to the one you are dragging remains anchored.  This 

enables you to change the position of the line, to extend it, or shorten it.  
 
NOTE:  Press Shift while re-sizing a line if you want it to stay at the same angle. 
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Aligning Objects 
 
To align objects 
using the Draw 
menu 

• Select the objects you wish to align.  
• Click the Draw icon on the Drawing toolbar to display the Draw menu. 
• Select Align or Distribute to display the alignment sub-menu. 
• Choose the type of alignment you want.  The selected objects align according 

to your selection. 
 
NOTE:  Objects are aligned according to their selection rectangles, rather than the 
shapes themselves. 
 

To align objects 
using guides 

• You can also align objects using vertical and horizontal guides. 
• From the View menu select Guides, or click the right-hand mouse button to 

display the Shortcut menu, and select Guides. 
• Vertical and horizontal dotted lines are displayed showing the center point of 

the slide. 
• Click on the vertical or horizontal dotted line and drag the line.  A Guide 

indicator is displayed with a number indicating, in inches, how far you have 
moved from the center of the slide.  

 
NOTE:  If the Guide indicator jumps numbers as you drag the Guides, switch off 
the Snap to Grid command in the Draw menu. 
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Moving Objects 
 
To move an 
object 

• If the object is filled, place the mouse pointer anywhere on the object to select 
it.  If it is a drawn object or picture, click on its border to select it. 

• Press the left-hand mouse button and drag.  As you drag the object, a dotted 
outline of it is displayed. 

• Move the outline to the new location and release the mouse button. 
 

To enable “Snap 
to grid” 

• Click the Draw icon on the Drawing toolbar to display the Draw menu. 
• Select Snap and make sure that “To Grid” is selected.  Once enabled, an 

invisible grid is place on the screen and when you drag objects they jump 
from one grid line to the next.  This helps in the alignment of objects. 

 
To disable “Snap 
to grid” 

• Click the Draw icon on the Drawing toolbar to display the Draw menu. 
• Select Snap and make sure that “To Grid” is not selected. 
 

To temporarily 
disable “Snap to 
grid” 

• Depress the Alt key while dragging the object. 
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Rotating Objects 
 
To rotate objects Objects can be rotated as individual objects, or as groups or multiple 

selections. You can rotate objects in various ways. 
 

To rotate an 
object using the 
Drawing toolbar 
 

• Select the object or group you wish to rotate. 
• Click on the Free Rotate tool on the Drawing toolbar.  The mouse pointer 

changes to the Free Rotate pointer. 
• Place the Free Rotate pointer over one of the re-size handles. 
• Drag the pointer and rotate the outline of the selection to the position you 

require. 
  

To rotate an 
object using the 
Draw menu 

• Select the object or group that you wish to rotate. 
• Click the Draw icon on the Drawing toolbar to display the Draw menu. 
• Select Rotate or Flip to display the Rotate or Flip sub-menu. 
• Here you can choose to Free Rotate an object, or to Rotate Left or Rotate 

Right by 90 degrees. 
• You can also flip the selection to turn the object or group horizontally or 

vertically by choosing Flip Horizontal or Flip Vertical. 
• Click the option you require to select it. 
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Cutting, Copying, Pasting and Duplicating 
 
Background Graphic objects can be cut, copied and pasted on a PowerPoint slide using the 

Cut, Copy, and Paste icons on the Standard toolbar, or the commands in the 
Edit menu.  Objects can be cut and copied from one slide to another, or from one 
presentation to another.  Whenever you use the cut and copy commands, a copy 
of the object is placed on the Clipboard until you paste it into another location.  
The Duplicate command is different.  When you duplicate an object, a copy of it is 
not stored on the Clipboard.  Duplicating an object means that you make a copy 
of it which is placed on the slide, slightly offset from the original object. 
 

To copy and 
paste an object 

• Select the object you wish to copy and from the Edit menu, select Copy to 
place a copy of the object on the Clipboard.  The object remains on the 
screen. 

• Position the cursor at the location where you want to paste the object from the 
Clipboard.  This can be on the same slide, or on a different slide. 

• From the Edit menu, select Paste.  A copy of the object is placed on the slide 
at the location of the cursor. 

 
NOTE: To quickly copy and paste objects use the Copy and Paste icons on the 
Standard toolbar. 



Pictures and Backgrounds  90 
PowerPoint 2003  Notre Dame University 

 
To cut and paste 
an object 

• Select the object you wish to cut and from the Edit menu, select Cut to 
remove the object from the slide and place it on the Clipboard. 

• Position the cursor at the location where you want to paste the object from the 
Clipboard.  This can be on the same slide, or on a different slide. 

• From the Edit menu, select Paste.  The object is placed on the slide at the 
location of the cursor. 

 
NOTE: To quickly cut and paste objects, use the Cut and Paste icons on the 
Standard toolbar. 
 

To duplicate an 
object 

• Select the object you wish to duplicate. 
• Select Duplicate from the Edit menu. 
• The duplicate is displayed on top of the object.  Click and drag to position the 

duplicate in the location required. 
 

To duplicate an 
object by 
dragging 

• Select the object you wish to duplicate. 
• Press the Ctrl key (a plus sign is displayed next to the pointer) and drag a 

copy of the object to a new location. 
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Moving Objects Forwards or Backwards 
 
Background When you draw objects on a slide, the first object you draw is on the bottom, and 

the last object you draw is on the top.  The placement of objects can be changed 
using the Bring to Front, Send to Back, Bring Forward and Send Backward 
commands. 
 

To bring objects 
forwards or send 
them backwards 

NOTE: This is only relevant where two objects overlap on the slide. 
 
• Select the object you wish to move forward or backwards. 
• Right click to display a pop-up menu, as illustrated. 
 

 
 

 
• Select Order to display the Order sub-menu. 
• Select Bring To Front or Send To Back. 
• The selected object is moved to the top or bottom of the stack. 
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Adding a Custom Background 
 
To add a shaded 
background 

PowerPoint offers a choice of backgrounds where a solid color gradually changes 
from light to dark or dark to light.  The color of the shading can be adjusted to suit 
your requirements. 
 
• Select Background from the Format menu, to display the Background 

dialog box. 
• In the Background box click the down arrow in the bottom right of the 

Background fill box to display the drop down menu. 
• Select Fill Effects to display the Fill Effects dialog box. 
• Select the Gradient tab to display the Gradient folder. 
• The Colors section of the dialog box allows you to choose from a range of 

preset colors or select up to two of your own.  Select options as required.  A 
sample of the fill effect is shown in the bottom right corner of the Fill Effects 
dialog box. 

• The Shading Styles section of the dialog box allows you to select the 
orientation of the fill effect.  Select the required option. 

• The Variants section of the dialog box allows you to select from up to four 
different versions of the fill effect.  Select the Variant you require. 

• Select OK to return to the Background dialog box. 
• To change the background color of the current slide only, click on Apply.  To 

change the background color of all slides in the presentation, click on Apply 
To All. 

 
NOTE:  You can see the effect that changes to a color scheme has had on your 
presentation by changing to Slide Sorter View. 
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The Format Painter 
 
To copy a Color 
Scheme from one 
slide to another 

• The simplest way to apply a color scheme to another slide, or another 
presentation, is to use the Format Painter tool.   

• First select text or an object to which you have applied formatting. 
• Click on the Format Painter icon on the Standard toolbar 
 

OR if you intend to copy the color scheme to more than one slide, double-click 
on the Format Painter icon. 

 
• The formatting information is picked up from the selected object and the 

mouse pointer changes to an arrow with a paintbrush attached. 
• Select the object to which you want to apply the formatted information by 

clicking on them.   
• If you were copying the color scheme to more than one object, then when 

finished you will need to press the Esc key to cancel the Format Painter. 
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Review Questions – How Would You … 
 

1.  Draw a line? 
 

2.  Draw rectangles and oval? 
 

3.  Edit a Freeform shape? 
 

4.  Add an AutoShape? 
 

5.  Change to a different AutoShape? 
 

6.  Select a single object? 
 

7.  Select more than one object at a time? 
 

8.  Select all the objects on a slide? 
 

9.  Cycle round all the objects within a slide? 
 

10.  Group objects? 
 

11.  Un-group objects? 
 

12.  Re-size Objects? 
 

13.  Constrain objects when you re-size them? 
 

14.  Align Objects? 
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15.  Move Objects? 

 
16.  Enable “Snap to grid”? 

 
17.  Rotate Objects? 

 
18.  Cut, Copy, Paste and Duplicate objects? 

 
19.  Move Objects Forwards and Backwards? 

 
20.  Add a Custom Background? 

 
21.  Display the drawing pop-up menu? 

 
22.  Insert a Text Box? 

 
23.  Insert a WordArt object? 

 
24.  Fill an object with a color, texture or picture effect? 
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Printing a Presentation 
 
 
 

Learning Module Objectives 
 
When you have completed 
this learning module you will 
have seen how to: 

• Print acetates 
• Print delegate handouts 
• Print presenters notes 
• Print a presentation outline 
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How do you want to print your Presentation? 
 
Background If you wish to give your presentation using any of the following methods you will 

need to output through a printer. 
 
• Acetates for overhead projection. 
• Delegate Handouts (2, 3, or 6 slides per page). 
• Presenters Notes. 
• Presentation Outline. 

 
Printing 
Acetates 

The printing of acetates can be achieved directly onto acetate (always check your 
printer is capable of this) or onto paper for copying onto acetate sheets. 
 

Printing 
Delegate 
handouts 

These can be printed in three formats either 2,3, or 6 slides per page.  
 
When printing 2 or 6 slides per page you are in effect producing a visual record of 
the presentation and there is little space for the addition of notes by delegates. 
 
The 6 slides per page handout is very useful as a quick visual reference for the 
presenter. 
 
When a 3 slide handout is produced the slides are placed on the left hand side of 
the page with space for notes to the right of each slide and as such are useful if 
your delegates are likely to want to make notes. 
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Printing 
Presenters 
Notes 

Presenter’s notes are produced 
within Microsoft PowerPoint and 
effectively have a single slide on the 
page with notes entered by the 
presentation creator. (See right) 
 
If the creator has not entered any notes 
presenters notes are printed with a 
single slide at the top of each page.  
This will allow for presenters to Write (or 
Scribble) their own directions etc. 
 

 
 

Printing a 
Presentation 
Outline 

When the presentation outline is printed the output is simply a text-based outline of 
the presentation.  It can contain only slide titles, or it can be the full presentation 
content. 
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The Print Dialog Box 
 
 The Print dialog box, as shown above, has four distinct sections, Printer, Print 

range, Copies and Print what. 
 

The Print dialog 
box – Printer 
section 

This section displays information regarding the currently selected printer.  You can 
change the printer setup via the Properties button.  If you want to print to a file 
check the Print to file check box. 
 

The Print dialog 
box – Print 
range section 

This section enables you to define what to print.  The options available are:  
• All - the whole presentation 
• Current slide - the currently selected slide 
• Selection - a subset of the presentation selected by the mouse 
• Slides - a selection of contiguous and/or non-contiguous slides 
 

The Print dialog 
box – Copies 
section 
 

This region of the dialog box allows you to enter the number of copies required and 
whether you want them collated or not. 

The Print dialog 
box - Print what 
section 

This is the final area of the dialog box and it contains the following options: 
 
   

 Print what Slides, Handouts (2, 3 or 6), Notes Pages, Outline View 
 Print hidden slides Yes/No 
 Black & white Yes/No 
 Scale to fit paper Yes/No 
 Frame slides Yes/No 
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To print 
acetates 

• Open the File menu.  
• Select the Print option. 
• If required select the appropriate printer. 
• Select the required print range. 
• Select the number of copies. 
• Select Print what – Slides. 
• NOTE: Check Pure black and white box if colored output is not required. 
• Check the Scale to fit paper box. 
• Check the Frame Slides box if you require your slides to be framed. 
• Click OK to commence printing.  
 

To print 
delegate 
handouts 

• Open the File menu.  
• Select the Print option. 
• If required select the appropriate printer. 
• Select the required print range. 
• Select the number of copies. 
• Select Print what - Handouts (appropriate version).     
• Check Pure black and white box if colored output is not required. 
• Click OK to commence printing.  
 

To print 
presenters 
notes 

• Open the File menu.  
• Select the Print option. 
• If required select the appropriate printer. 
• Select the required print range. 
• Select the number of copies. 
• Select Print what - Notes Pages.    
• Check Pure black and white box if colored output is not required. 
• Click OK to commence printing. 
 

To print a 
presentation 
outline 

• Open the File menu.  
• Select the Print option. 
• If required select the appropriate printer. 
• Select the required print range. 
• Select the number of copies. 
• Select Print what - Outline View.    
• Check Pure black and white box if colored output is not required. 
• Click OK to commence printing. 
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Review Questions – How Would You … 
 

1.  Print acetates? 
 

2.  Print delegate handouts? 
 

3.  Print presenter’s notes? 
 

4.  Print a presentation outline? 
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Creating and Running a Slide Show 
 
 
 

Learning Module Objectives 
 
When you have completed this 
learning module you will have 
seen how to: 

• Set up a slide show 
• Start a slide show 
• Move to the next slide 
• Move to a previous slide 
• Return to the first slide 
• Exit a screen show 
• Add transitions to a slide show 
• Set timings for a slide show 
• Add annotations during a slide show 
• Hide slides in a slide show 
• Make a slide title drop in during a show 
• Make text build one paragraph at a time 
• Make text “drive” into the slide 
• Make text “fly” into the slide 
• Make text “shutter” into the slide 
• Make text or object flash 
• Make text/objects appear from the top right of a slide 
• Make text appear one character at a time 
• Make text “rain” from the top of a slide 
• Display the Meeting Minder dialog box while editing a slide 
• Display the Meeting Minder dialog box while running a slide 

show 
• Display the slide show shortcuts 
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What is a Slide Show? 
 
Background Rather than printing out your presentation, you may want to run it as an electronic 

slide show on your computer. 
 
This means that each slide in your presentation, along with its text, art, and 
graphics, takes up the whole screen.  All other screen elements are hidden. 
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Navigating Through a Slide Show 
 
To start a slide 
show 

• Click the Slide Show icon or select the Slide Show command from the 
View menu. 

 
To move to the next 
slide 

Use any of the following options: 
• Left Mouse Click 
• N 
• Space Bar 
• Right Arrow 
• Down Arrow 
• Enter  
• Page Down 
• Right Click - Select from Pop-up Menu 
 

To move to a 
previous slide 

Use any of the following options: 
• Backspace 
• P 
• Left Arrow 
• Up Arrow 
• Page Up 
• Right Click - Select from Pop-up Menu 

 
To return to the first 
slide 
 

• Press both mouse buttons for 2 Seconds. 
 

To blank the screen 
to black 

• Press B once to apply. 
• Press B once more to remove. 
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To blank a screen 
to white 

• Press W once to apply. 
• Press W once more to remove. 

 
To exit a screen 
show 

Use any of the following options: 
• Esc 
• Ctrl+Break 
• “-“  

The slide show 
"right click menu" 

Right clicking within the slide show will display the flowing pop-up menu, 
allowing you to navigate through the presentation. 
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Slide Show Transitions 
 
To add 
transitions to a 
slide show 

Transitions are special effects you can add to a slide show to determine how 
one slide moves to the next. 
 
• Change to Slide Sorter view by clicking on the Slide Sorter icon. 
• Select Slide Transition from the Slide Show menu, to display the Slide 

Transition dialog box. 
• Select the transition you require from the Effect drop down list.   
• Click on the transitions to see a preview of them applied to the picture in the 

Preview box.  To see the transition again, click on the picture. 
• Select how fast you want the transition to take place by selecting Slow, 

Medium, or Fast.  You can preview the speed you have chosen in the Preview 
box. 

• To change the transition of the current slide only, click on Apply.  To change 
the transition of all slides in the presentation, click on Apply To All. 
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Slide Show Timings 
 
To set timings 
for a slide show 

Each slide in your slide show can have a different timing applied to it.  For instance, 
the first slide may appear for 10 seconds, the second for 20 seconds, the third for 5 
seconds.  You can set timings in the following ways. 
 
• You can set timings, by allowing PowerPoint to set the times for you. 
• Select Rehearse Timings from the Slide Show menu.   
• The slide show appears on the screen.  In the top left-hand corner of the screen 

a button is displayed with a clock.  The clock shows you how long the slide has 
been on the screen.  When you are ready to move to the next screen, click 
anywhere on the slide, or on the clock button. 
 

 
 

• When you reach the end of the presentation a dialog box is displayed telling you 
the total time taken for the slide show. 

 
 

• You will be asked if you want to record the new timings and use them in slide 
show view.  Select Yes to record the new timings, or No to cancel them. 

 
To see the 
timing for each 
slide 

Switch to Slide Sorter view and the timings for each slide will be displayed below 
the slide. 
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Slide Show Annotations 
 
To add 
annotations 
during a slide 
show 

When you are running a slide show it is possible to add freehand annotations to 
draw attention to a particular part of the slide. 
 
• Begin the slide show. 
• Click the right mouse button to display the shortcut menu. 
• Select Pointer Options from the pop-up menu displayed. 
• Select Pen from the sub-menu displayed. 
• Hold down the left mouse button to write or draw on the screen. 
• To erase annotations during a slide show press the E key.  When you move to 

the next slide the annotations will disappear. 
• When finished, press the Esc key to turn the feature off. 
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Hidden Slides 
 
To hide slides in 
a slide show 

• Select the slide(s) you wish to hide. 
• Select Hide Slide from the Slide Show menu, or click on the Hide Slide icon 

on the Slide Sorter toolbar if you are working in Slide Sorter view. 
• The slide will be hidden during a slide show. 
• In Slide Sorter view an icon appears below the slide, which contains the slide 

number with a line through it, to indicate that it is hidden. 
• During a slide show, if you wish to display a hidden slide right-click on the 

preceding slide to display the shortcut menu, select Go and then Hidden Slide 
or simply press the H key. 

 
To see which 
slides are 
formatted as 
hidden 

• Switch to slide sorter view and the hidden slide(s) will be indicated as illustrated 
below. 

 

 
To display a 
hidden slide 
during a slide 
show 

Within the slide show right-click on the slide that precedes the slide that is hidden.  
Click on the Go command, and then click on the hidden slide to display it.  
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What are Animation Effects? 
 
To display the 
animation 
toolbar 

• Click on the View drop down menu and select the Toolbars command.  From 
the sub-menu displayed select Animation Effects. 
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Slide Show Shortcuts 
 
To display 
the slide 
show 
shortcuts 

When the slide show 
is running press the 
F1 key to display a 
list of shortcuts. 
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Review Questions – How Would You … 
 

1.  Start a slide show? 
 

2.  Move to the next slide? 
 

3.  Move to a previous slide? 
 

4.  Return to the first slide? 
 

5.  Exit a screen show? 
 

6.  Add transitions to a slide show? 
 

7.  Set timings for a slide show? 
 

8.  Add annotations during a slide show? 
 

9.  Hide slides in a slide show? 
 

10.  Make a slide title drop in during a show? 
 

11.  Make text build one paragraph at a time? 
 

12.  Make text “drive” into the slide? 
 

13.  Make text “fly” into the slide? 
 

14.  Make text “shutter” into the slide? 
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15.  Make text or object flash? 

 
16.  Make text/objects appear from the top right of a slide? 

 
17.  Make text appear one character at a time? 

 
18.  Make text “rain” from the top of a slide? 

 
19.  Display the Meeting Minder dialog box while editing a slide? 

 
20.  Display the Meeting Minder dialog box while running a slide show? 

 
21.  Display the slide show shortcuts? 

 
22.  Preview the transition effect for a slide? 
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Installing the Sample Files into a Folder 
Installing the sample files 
• Use the Windows Explorer to copy  PowerPoint 2003 samples from your exercises diskette, just 

below the My Documents folder. 
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Introduction to PowerPoint 
Opening an Existing Presentation 
• Open an existing presentation called LOOKATME, which is contained in the folder called: 

/MY DOCUMENTS/ PowerPoint 2003 samples. 
• Use the Page Down key to view the slides, one at a time. 
• Close the file. 
 
 

Opening more than one file at a time 
• Click on the Open icon located on the Standard toolbar. 
• Make sure that you can see the files located in the: 

/MY DOCUMENTS/ PowerPoint 2003 samples folder  
Click once on the first file to select it. 

• Depress the Shift key, and click once on the last file in the list.  Release the Shift key and all the 
files will remain selected. 

• Click on the Open button and all the files will be opened. 
• Even though you have opened more than more presentation, you will only see one slide from a 

particular presentation displayed on the screen.  To switch to another open presentation, click on 
the Window drop down menu and from the list displayed at the bottom of this menu, click on the 
presentation that you wish to view. 
 
TIP: To switch to other open presentations using the keyboard, press Ctrl+F6.  Try this now! 
 

• Close all your files. 
 
 

Opening recently used PowerPoint files 
• Click on the File drop down menu, and from the list displayed, open a recently used PowerPoint 

file.  
• Open the Options dialog box and increase the list of recently opened files.  To do this click on the 

Tools drop down menu and select Options. Click on the General tab and increase the value in the 
Recently used file list making sure its check box is selected. 

 
 

Investigate the Open dialog options 
• Display the Open dialog box. Then experiment with moving up one folder level.  Experiment with 

viewing the files properties. Close the Open dialog box. 
 
 

Saving a presentation with a different file name 
• Open a file called LOOKATME.  Use the SaveAs command to re-save this file with a different file 

name, rename it as MYPRES1. Close the file without saving your changes. 
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The PowerPoint Screen and Views 
The Standard Toolbar 
• Examine the icons contained within the Standard toolbar.  At this stage some of the icon names 

may not mean much, but try to get a feel for what is available via this toolbar.  You may like to 
experiment with using some of the icons!  You can also use the Help to gather additional 
information. 
 

 
 
 

The Formatting Toolbar 
• Examine the icons contained within the Formatting toolbar.  At this stage some of the icon names 

may not mean much, but try to get a feel for what is available via this toolbar.  You may like to 
experiment with using some of the icons!  You can also use the Help to gather additional 
information. 
 

 
 
 

Status Bar 
• Open a file called LOOKATME.  
• Examine the information displayed via the Status Bar. 
 
 

The View Icons 
• Examine how this presentation looks using the various views listed below.  Use the view icons 

location at the bottom-left of the screen. 

 
 
• Normal 
• Outline View. 
• Slide View. 
• Slide Sorter View. 
• Slide Show View. 

 
• Close the file without saving any changes you may have made.
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Using AutoLayout 
Creating a Title slide 
• Re-start PowerPoint and when the first dialog box is displayed select the Blank Presentation 

option and click on the OK button. 
• When the New Slide dialog box is displayed make sure that the Title Slide is highlighted (i.e. the 

first box is selected) and then click on the OK button. 
• Click on the area of the slide displaying the text “Click to add title” and enter some text such as My 

first presentation. 
• Click on the area of the slide displaying the text “Click to add sub-title” and enter some text, such 

as your name. 
 
 

Creating a Bulleted List Slide 
• Click on the Insert drop down menu and select the New Slide command. 
• Select the next AutoLayout option called Bulleted List and click on the OK button. 
• Click on the area of the slide displaying the text “Click to add title” and enter a short title for this 

slide. 
• Click on the area of the slide displaying the text “Click to add text” and enter a few short lines of 

text (pressing the Enter key at the end of each line). 
 
 

Creating a Two Column Text Slide 
• Click on the Insert drop down menu and select the New Slide command. 
• Select the next AutoLayout option called 2 Column Text and click on the OK button. 
• Click on the area of the slide displaying the text “Click to add title” and enter a short title for this 

slide. 
• Click on the first area of the slide displaying the text “Click to add text” and enter some text such 

as My first presentation. 
• Click on the second area of the slide displaying the text “Click to add text” and enter a few short 

lines of text (pressing the Enter key at the end of each line). 
 
 

Creating a Table Slide 
• Click on the Insert drop down menu and select the New Slide command. 
• Select the next AutoLayout option called Table and click on the OK button. 
• Double click on the Table icon to add a table. 
• Use the defaults within the dialog that is displayed and click on the OK button. 
• A table will be inserted.  Enter some text into the first table cell. 
• Press the Tab key to jump to the next slide and enter more text in the cell. 
• Repeat this procedure until you have entered some text into each cell. 
• Click once on the slide on an area outside the table.  This will de-select the table and allow you to 

continue. 
 
 

Creating a Text and Chart Slide 
• Click on the Insert drop down menu and select the New Slide command. 
• Select the next AutoLayout option called Text & Chart and click on the OK button. 
• Click on the area of the slide displaying the text “Click to add title” and enter a short title for this 

slide. 
• Click on the area of the slide displaying the text “Click to add text” and enter a few short lines of 

text. 
• Double click on the Chart icon to add a chart. 
• Click once on the slide on an area outside the chart.  This will de-select the chart and allow you to 

continue. 
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Using Other AutoLayout formats 
• If you have time, experiment with some of the other AutoLayout formats that are available. 
• Close the file without saving your changes. 
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Wizards for AutoContent and Look 
Starting the AutoContent Wizard – When you start PowerPoint 
• Re-start PowerPoint. 
• Click on the AutoContent Wizard option displayed in the first dialog box that you see. 
• Click on the OK button. 
• Follow through the AutoContent wizard, and after each step, click on the Next button. 
• When you reach the final step of the wizard, the presentation will be produced for you. 
• You may find that the presentation is displayed in Outline view, in which case if you wish to see 

how the actual slides look, click on the Slide View icon (located at the bottom, left of the screen).  
Use the Page Down key to move through the presentation. 

• Close the file without saving your changes. 
 
 

Starting the AutoContent Wizard – Once PowerPoint has 
already been started 
• Click on the File drop down menu and select the New command, in the dialog box displayed select 

the General tab. 
• Click on the AutoContent Wizard icon and then click on the OK button. 
• This time try creating a presentation of a different type. 
• When you have finished experimenting with this presentation, close the file without saving your 

changes. 
• Experiment with creating other presentations using the AutoContent wizard that sound like they 

may be useful to you.  Try to get a feel for what is available using this powerful presentation 
creation technique. 

• Close the files you have created without saving your changes. 
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Creating a Simple Text Slide 
Creating a New Blank Presentation in Slide Layout View 
• If necessary close PowerPoint and then re-start it. 
• Create a new presentation using a front Title Slide AutoLayout. 
• Then add a few more slides using the Bulleted List AutoLayout. 
 
 

Modifying Your Slides 
• Experiment with entering a new line that is not preceded by a bullet point.  To do this press 

Shift+Enter and the end of a line (instead of Enter).  When you enter a line of text it will not be 
preceded by a bullet. 

• Experiment with demoting bullets using the Tab key. 
• Experiment with promoting sub-level bullets using Shift-Tab. 
• Experiment with demoting bullets using the Demote icon. 
• Experiment with promoting bullets using the Promote icon. 
• Close the file without saving your changes. 
 
 

Create a Text Slide in Outline View 
• Start a new presentation and switch to Outline View. 
 
 

Adding Slide Titles 
• Experiment with entering a few slide titles while in Outline View 
 
 

Adding Bullet Points 
• Experiment with adding a few lines of bulleted text in Outline mode. 
 
 

Sub-Level Bullets 
• Experiment with demoting bullet levels in Outline view using the Tab key. 
• Experiment with demoting bullet levels in Outline view using the Demote icon. 
• Experiment with promoting sub-level bullets in Outline view using the Shift-Tab key. 
• Experiment with promoting sub-level bullets in Outline view using the Promote icon. 
 
 

To Start a New Slide in Outline View 
• Experiment with inserting new slides. 
 
 

Manipulating Slides in Outline View 
• Experiment with moving slides/bullets. 
• Experiment with reducing the view of a slide to title only. 
• Experiment with expanding a collapsed slide. 
• Experiment with collapsing all slides. 
• Experiment with expanding all slides. 
• Experiment with creating a Summary Slide. 
• Experiment with toggling the “Show Formatting” display. 
• Close the file without saving your changes. 
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Formatting and Proofing Text 
Select Then Do! 
• Open a file called SELECT. 
• Experiment with selecting a word.  To do this place the cursor within a word and double click. 
• Experiment with selecting characters using the mouse. To do this position the mouse pointer at 

the point where you wish to start selecting text. Depress the left mouse button and move the 
mouse in any direction.  When the required text is highlighted, release the mouse button and the 
text will remain selected. 

• Experiment with selecting characters using the Keyboard. To do this hold down the Shift key 
and select the characters you wish to format with the up, down, left, and right cursor keys. 

 
 

Text Formatting 
• Experiment with changing the font type.  To do this select text to be changed then click on the 

Font drop down arrow and select the required font. 

 
 

• Experiment with changing font size.  To do this select text to be changed and then click on the 
Size drop down arrow and select the size you require. 

 
 

• Experiment with making text bold.  To do this select text to be changed and then click on the 
Bold icon. 

 
 

• Experiment with displayed text in italics. To do this select text to be changed and then click on 
the Italic icon. 

 
 

• Experiment with underlining text. To do this select text to be changed and then click on the 
Underline icon. 

 
 

• Experiment with giving text a shadow effect. To do this select text to be changed and then click 
on the Text Shadow icon. 
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Experiment with changing text color.  To do this select text to be changed and then click on 
down arrow to the right of the Font Color icon (located on the Drawing toolbar). 

 
 

• Experiment with adjusting text alignment. To do this select text to be changed and then click on 
the Alignment icons. 

   
 

• Experiment with formatting text using the Format drop down menu.  To do this select text to 
be changed.  Open the Format menu and select the Font option to display the Font dialog box.  
Select the appropriate items from those available. 
 

• Close the file without saving your changes. 
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Pictures and Backgrounds 
Using the Drawing Tools 
• Create a new presentation. 

 
• Experiment with drawing a line. To do this select the Line icon from the Drawing toolbar and the 

mouse pointer changes into a cross-hair pointer when moved over the slide.  Click at the location 
where you want the line to begin and drag.  Release the mouse button when you want the line to 
end and a line appears between the beginning and end point. 
 

 
 

• Experiment with formatting your line. To do this select the line double click on it to display the 
Format AutoShape dialog box and then experiment with using the options displayed. 
 

• Experiment with draw rectangles and ovals. To do this select the Rectangle or Oval icon from 
the Drawing toolbar and the mouse pointer changes into a cross-hair pointer when moved over the 
slide.  Click at the location where you want the rectangle or oval to begin and drag to draw the 
object.  When you have finished, release the mouse button.  Again experiment with formatting the 
objects that you have created by double clicking on them and using the options in the dialog box 
displayed. 

 
 

AutoShapes 
• Experiment with adding AutoShapes. To do this click the AutoShapes button on the Drawing 

toolbar to display the AutoShapes menu.  Move up or down the pop-up menu to displayed groups 
of different types of AutoShapes, such as Lines of Block Arrows. From the sub-menu displayed, 
click on the AutoShape you require to select it.  Position the mouse pointer at the location where 
you want the AutoShape to begin.  Hold down the left-hand mouse button and drag to position the 
AutoShape on the slide.  Release the mouse button when the shape is the size and proportion you 
require.  
 

• Experiment with formatting the AutoShape objects that you have created.  To do this double 
click on the AutoShape and used the options in the dialog box that is displayed. 

• Close the file without saving your changes. 
 
 

Using ClipArt 
• Create a new presentation. 
• Click on the Insert Clip Art icon, located in the Drawing toolbar.  You may see a small dialog box 

reminding you that there is much more clip art available on the Microsoft Office CD-ROM 
installation disk.  If you do see this informational dialog, press OK to continue.  A gallery of clipart 
will be displayed.  Select the group that matches your requirements, such as Academic or 
Animals. 

• Click on the piece of clip art you wish to insert into your slide, a pop-up menu will be displayed.  
Click on the Insert Clip icon (located at the top of the pop-up menu). 

• Close the Insert Clip Art dialog box. 
• Close the file without saving your changes. 
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Selecting Objects 
• Open a file called OBJECTS. 

 
• Experiment with selecting and deselecting single objects.  To do this click on and object to 

select it and then click on something else to de-select it. 
 

• Experiment with selecting more than one object at a time. To do this click on the first object you 
want to select and then press the Shift key.  Keeping the Shift key depressed, click on the next 
object you wish to select and the first object remains selected.  Continue selecting objects as 
required. 
 

• Experiment with selecting all the objects on a slide.  To do this click on the Select All command 
from the Edit menu, or press Ctrl+A. 
 

• Experiment with cycling round all the objects within a slide.  To do this select one object.  Then 
use Tab key to cycle through all the objects of the slide (use Shift+Tab to cycle through in the 
reverse direction). 
 

• Close the file without saving your changes. 
 
 

Grouping and Un-grouping Objects 
• Open a file called OBJECTS. 

 
• Experiment with grouping objects.  To do this select the objects you wish to group, either by 

clicking on each object while holding down the Shift key, (or by using the mouse to drag a selection 
rectangle around each object you want to select).  Click the Draw icon on the Drawing toolbar to 
display the Draw menu and select Group.  The handles around each individual object disappear, 
and handles are displayed around the selection rectangle which encompasses the object group. 
Select the grouped object group and you will find that dragging and dropping moves all the objects 
that have been grouped. 
 

• Experiment with un-grouping objects. To do this select the grouped objects.  Click the Draw icon 
on the Drawing toolbar and select Ungroup.  The handles around the group disappear, and the 
handles are restored for each object.  Clicking on something else to de-select the objects and then 
you will find that you can use drag and drop to move the individual objects once again. 
 

• Using right clicking to group and un-group.  Select two separate objects and then right click.  
Use the pop-up menu to first group these objects and then to un-group them. 
 

• Close the file without saving your changes. 
 
 

Re-sizing Objects 
• Open a file called OBJECTS. 

 
• Experiment with re-sizing objects. To do this click on an object to select it.  Click on one of the 

re-size handles around the object and the mouse pointer changes to a cross-hair pointer.  Drag the 
re-size handle until the object is the size you require, and release the mouse button. 
 

• Experiment with re-sizing an object to exact percentages.  To do this right click on the object 
and from the shortcut menu select Format.  Click on the Size tab to display the Size folder.  To re-
size the selection by an exact percentage, adjust the Height and Width spin boxes in the Scale 
section of the dialog box.  Select OK. 
 

• Experiment with resizing while keep the height and width proportions the same.  To do this 
hold down the Shift key and click on one of the corner handles of a selected object then drag to re-
size. 
 

• Close the file without saving your changes. 
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Aligning Objects 
• Open a file called OBJECTS. 

 
• Experiment with aligning objects.  To do this select the objects you wish to align. Click the Draw 

icon on the Drawing toolbar to display the Draw menu.  Select Align or Distribute to display the 
alignment sub-menu.  Choose the type of alignment you want and the selected objects align 
according to your selection. 
 

• Close the file without saving your changes. 
 
 

Moving Objects 
• Open a file called OBJECTS. 
• Experiment with moving objects.  To do this select an object and then drag and drop it to the new 

location. 
 

• Experiment with using “Snap to grid” and moving objects.  To do this click on the Draw icon on the 
Drawing toolbar to display the Draw menu.  Select Snap and make sure that “To Grid” is selected.  
Once enabled, an invisible grid is placed on the screen and when you drag objects they jump from 
one grid line to the next.  This helps in the alignment of objects. 
 

• Close the file without saving your changes. 
 
 

Rotating Objects 
• Open a file called OBJECTS. 

 
• Experiment with rotating objects.  To do this select the object you wish to rotate.  Click on the 

Free Rotate tool on the Drawing toolbar.  The mouse pointer changes to the Free Rotate pointer.  
Place the Free Rotate pointer over one of the re-size handles and drag the pointer and rotate the 
outline of the selection to the position you require. 
 

• Close the file without saving your changes. 
 
 

Cutting, Copying, Pasting and Duplicating 
• Open a file called OBJECTS. 

 
• Experiment with copying objects to the Clipboard and them pasting them back to your 

presentation.  To do this select the object you wish to copy and from the Edit menu, select Copy 
to place a copy of the object on the Clipboard.  The object remains on the screen.  Position the 
cursor at the location where you want to paste the object from the Clipboard.  From the Edit menu, 
select Paste and a copy of the object is placed on the slide at the location of the cursor. 
 

• Experiment with duplicating objects using the drop down menus and also by using “drag 
and drop” techniques.  To do this select the object you wish to duplicate.  Press the Ctrl key (a 
plus sign is displayed next to the pointer) and drag a copy of the object to a new location. 
 

• Close the file without saving your changes. 
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Moving Objects Forwards and Backwards 
• Open the file called ONTOP. 

 
• Experiment with using the Bring To Front and Send To Back commands.  To do this select the 

object you wish to move forward or backwards and when you right click a pop-up menu is 
displayed.  Experiment with using the options within this pop-up menu. 
 

• Experiment with using the Bring Forward and Send Backward commands.  Use the 
techniques outlined above. 
 

• Close the file without saving your changes. 
 
 

Using Color Schemes 
• Open the file called LOOKATME. 

 
• Experiment with applying color schemes.  To do this from the Format menu, select Slide Color 

Scheme to display the Color Scheme dialog box. Click on the Standard tab and select one of the 
standard schemes.  Click on the Preview button to see the effect that the select option will have on 
any slide that you have created.  Click on the Apply to All button to apply the scheme to all the 
slides in the Presentation or on the Apply button to just apply the color scheme to the current slide. 

 
 

The Drawing Toolbar 
• Examine the icons contained within the Drawing toolbar.  You may like to experiment with using 

some of the icons!  You can also use the on-line Help to gather additional information. 
 
 

The Format Painter 
• Create a new slide and enter a few paragraphs of text.  Format each paragraph using different 

types of fonts, different font colors, different fonts sizes etc.  Then experiment with using the Format 
Painter.  To do this, first select some text and then click on the Format Painter icon in the Standard 
toolbar (OR if you intend to copy the color scheme to more than one slide, double-click on the 
Format Painter icon).  The formatting information is picked up from the selected text and the mouse 
pointer changes to an arrow with a paintbrush attached.  Select the some other text to which you 
want to apply the formatted information by clicking on them.   
 

• Close the file without saving your changes. 
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Printing a Presentation 
The Print Dialog Box 
• Examine the options available via the Print dialog box. 
• If you are connected to a printer, experiment with using some of these options. 
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Creating and Running a Slide Show 
Running a Slide Show 
• Open a file called LOOKATME. 
• Run the slide show.  To do this click the Slide Show icon. 
 
 

Navigating Through a Slide Show 
• Experiment with moving to the next slide.   

To do this use any of the following options: 
Left Mouse  
N 
Space Bar 
Right Arrow 
Down Arrow 
Enter 
Page Down 
Right Click - Select from Pop-up Menu 
 

• Experiment with moving to the previous slide.   
To do this use any of the following options: 
Backspace 
P 
Left Arrow 
Up Arrow 
Page Up 
Right Click - Select from Pop-up Menu 
 

• Experiment with returning to the first slide.  To do this depress both mouse buttons for 2 seconds 
(or press the Home key). 
 

• Experiment with blanking the screen. To do this press B once to apply.  Press B once more to remove. 
 
 

Slide Show Transitions 
• Experiment with adding transitions to the slide show.  To do this change to Slide Sorter view by clicking 

on the Slide Sorter icon.  Select Slide Transition from the Slide Show menu, to display the Slide 
Transition dialog box.  Select the transition you require from the Effect drop down list.  Click on the 
transitions to see a preview of them applied to the picture in the Preview box.  To see the transition 
again, click on the picture.  Select how fast you want the transition to take place by selecting Slow, 
Medium, or Fast.  You can preview the speed you have chosen in the Preview box.  To change the 
transition of the current slide only, click on Apply.  To change the transition of all slides in the 
presentation, click on Apply to All. 
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Slide Show Timings 
• Experiment with setting timings for your slide show.  To do this select Rehearse Timings from the 

Slide Show menu. The slide show appears on the screen and in the top left-hand corner of the screen 
a button is displayed with a clock.  The clock shows you how long the slide has been on the screen.  
When you are ready to move to the next screen, click anywhere on the slide 
 

 
 
When you reach the end of the presentation a dialog box is displayed telling you the total time taken for 
the slide show.  Select Yes to record the new timings. 
 
To see your slide show timings that you have just recorded.  Switch to Slide Sorter view and the timings 
for each slide will be displayed below the slide. 

 
 

Slide Show Annotations 
• Experiment with adding annotations to your slide show.  To do this begin the slide show and click the 

right mouse button to display the shortcut menu.  Select Pointer Options from the pop-up menu 
displayed.  Select Pen from the sub-menu displayed.  Hold down the left mouse button to write or 
draw on the screen. To erase your annotations during a slide show press the E key.  When finished, 
press the Esc key to turn the feature off. 

 
 

Hidden Slides 
• Experiment with hiding slides in a slide show.  To do this select the slide(s) you wish to hide.  Select 

Hide Slide from the Slide Show menu, or click on the Hide Slide icon on the Slide Sorter toolbar if you 
are working in Slide Sorter view.  The slide will be hidden during a slide show. 
 

• Experiment with displaying hidden slides during a presentation. Run a slide show, and right-click 
on the preceding slide to display the shortcut menu, select Go and then Hidden Slide (or simply press 
the H key). 
 

• Close the file without saving your changes. 
 
 

The Animation Effects Toolbar 
• Open a file called LOOKATME. 
• Use the Save As command to save the file as MYMOVE. 
• Experiment with making a slide title drop in during a show.  To do this click on the View drop down 

menu and select the Toolbars command.  From the sub-menu displayed select Animation Effects.  
Select the required effect. 

• Experiment with making text build one paragraph at a time. 
• Experiment with making text “drive” into the slide. 
• Experiment with making text “fly” into the slide. 
• Experiment with making text or objects flash. 
• Experiment with making text/objects appear from the top right of a slide. 
• Experiment with making text appear one character at a time. 
• Experiment with making text “rain” from the top of a slide. 
• Close the file and save your changes. 
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